
 Manual Visual Cargo Care
Demo

1

Part I: Getting Started with VCC

QUICK START

When you first got your hands on VCC, you were probably focused on one goal—load, lash & secure your 
next load-out. I know that many of you bought VCC to make a professional calculation, use it in your method 
statement or check the last load-outs, if what you did in the past was safe. If you’ve perused this manual’s 
Table of Contents or thumbed through its many pages, you’ve seen sections on loading, ships, cargoes, and 
other topics.
But if you’re like me, you don’t want to wade through  all the beginners stuff before you have something to 
show off to. The purpose of this Quick Start is to give you a taste of what VCC can do. This soaring view of the 
software from 20,000 feet is intended to show you the big
picture before you delve into the details. It exposes you to some of the most common features and, I hope, 
whets your appetite for the more in-depth chapters to follow. This part of this manual is intended for those new 
to the software. If you’re an experienced user, so you can happily advance to whichever chapter appeals to 
you. (Forgive me for catering to the “newbie,” but we were all beginners once.)

Transformer 100mt - Hold 2
For this Quick Start, you’re going to load, Lash & secure a Transformer on a ship, look at the acceleration cal-
culations, change details and adjust the lashing and securing.

Go to the website http://www.visualcargocare.com/samples/gettingstarted/sample01.vcce
and download this sample file. Then open your import file handler and open the file you just downloaded. The 
sample will automatically put your sample01 project in the project explorer.

 
Click on the ship ‘VCC Default’ in your project explorer and you will see the just imported file in the tree-view 
named ‘2010-002 Getting Started01’ shown to you as a voyage.
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By clicking on it you will see the cargo in hold 2 of the ship. When you then click on the ‘plus (+)’ in front of the 
voyage you will see the cargo loaded on this voyage. 

Again click on the ‘12-3456 Sample01’ and the Lashing & Securing viewport will appear in the centre of the 
screen.

What you see in this examples is that we loaded a i.e. Transformer of 100 mt in hold 2 of the ship called VCC-
default. When the Lashing & Securing viewport is in front of you will see that the cargo is already lashed & 
secured and that the calculation in the Lashing calculations property box shows all green numbers, this means 
the cargo is safe for transport.

We will work around this example, just to show how you can play with the cargo on the ship and change all 
settings.
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Let’s start to play around
When clicking on the voyage the main view port will be looking like the one below.

 

Here you see that the Transformer is loaded in the Lower hold of the vessel called ‘VCC Default’.
By the way, this vessel is always present in your program. On the left side of the screen you will see the prop-
erty form ‘Cargo during voyage’. In this form you will see the specification of the cargoes properties. If you have 
more than one (1) item loaded, you can easily navigate through the records by clicking on the arrows on the 
bottom of this property form.

Position of the cargo
Let’s take a closer look at the property form ‘Cargo during voyage’. If the form is not show directly, it must be 
‘hidden’ on the left-side of your screen. By hovering over it with your mouse, it will re-appear. By clicking on the 
pin   in the top, you can choose to permanently stay there or hide it   after your mouse leaves the form. 
Most of these properties you filled out when adding the cargo into the program, but I will highlight a few topics. 
One of the most important is where did you load the cargo and how can you change the stowage position of 
your cargo. When you click under the header ‘Location’ on the field where is ‘hold 2’ you will see a dropdown 
list, which shows you the option where to load the cargo.

In this case the vessel has three holds and of course a weather deck, which covers the area over all holds 
available. This is used for longer items. From the dropdown list you select hold 3. The cargo will automatically 
change to the forward part of hold 3. The cargo then can be moved with your mouse all over the hold. When 
you go to top view of the lower hold (tank top), you can also change position to the port or starboard side of 
the vessel. Please try also to put the cargo on the weather deck of hold 1. You’ll see that it is easy to change 
the position of the cargo.
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Position
When playing the cargo around your ship with your mouse, you will notice that under ‘ Location ‘ the numbers 
will change where it says ‘cargo to....’ These are the coordinates from your cargo in that specific hold. Where 
it says minus it means that it will be on the portside of the centre line of your hold. By changing the numbers in 
the property box you can also change the position of your cargo.
Just try and play around a bit. 

Rotation
Here you can rotate the cargo. You have the option when degrees is selected to enter 0,90,180,270 as a 
number, the cargo will rotate. When your COG ( Centre of Gravity) is in the middle of your cargo (transverse 
and longitudinal) this will make no difference. But when your COG is offset, rotating the cargo will affect the 
position of the COG and therefore have influence on your acceleration forces.

Friction
Here you can select what friction-coefficient you want to use between the cargo and the deck. The value will 
be deducted from the acceleration forces.

- 0,0 for Steel - Steel (wet)
- 0,1 for Steel - Steel (dry)
- 0,3 for Steel - Timber ( for Steel -Rubber)
- 0,4 for Timber - Timber 

So depending on what you choose, you have to put more lashing to your cargo.
When you are surveyor or Cargo Superintendent, it will be wise to put the friction to zero (0).
This will give you some pocket change for bad weather. If you are a shipping line which has to give a method 
statement to their client I would suggest to put 0,3 for Steel - Timber. This will reduce your lashing and securing 
to a minimum, but still within IMO limits.

Estimated draught
When you choose the IMO CSS Annex 13 as your calculation for Acceleration this field appears to give the 
user the exact sailing draught after loading, this for better and more precise calculations.
As default the program will take the maximum draught from the ships properties. When filling out this field, the 
program will then calculate with this number.

When you choose the DNV Pt. 3 Cha. 1 Sec 4 as your acceleration calculation then this field will disappear.

So in a few minutes you learned already something:
- changing holds
- positioning of cargo, by mouse or by numbers
- rotation
- friction
- estimated draught

This is already something, maybe it is time to get a cup of coffee, or just to turn the page to the next topic.
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Acceleration Calculations
On the right side of the screen you will find the ‘Acceleration Calculations’ form.
Here you will find the differences of calculation between IMO CSS Annex13 and DNV.

Both calculation methods uses input values which are more or less the same.
In IMO calculations the cargo is always centered in the vessel, in DNV it uses the exact location (TCG) of the 
cargo. The DNV result is more precise. The results of the acceleration calculation are shown in the status bar 
in the bottom part of the form.

GM
Normally a vessel will leave the port having a GM ( stability figure) for the whole vessel.
Because in this program it is possible to plan more cargoes to load in different port, on different voyages, we 
decided to put the GM of that particular cargo, on that particular voyage , in that particular port with the ac-
celeration calculation of that specific cargo. When loading a new cargo this field will be empty and shown to 
you in red color. 

 
This means you have to add the GM, before the program can calculate. When all is okay in the bottom will be 
shown in green ‘Successful Calculation’.
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In the lower part of the form you will find the calculated accelerations for that specific cargo.
Acceleration numbers are calculated for:

IMO CSS Annex 13
- Longitudinal
- Transverse
- Vertical Head Seas

DNV Pt.3 Ch.1 Sec 4
- Longitudinal
- Transverse
- Vertical Head Seas
- Vertical Beam Seas

In the Status bar, at the lower part of the viewport you will see also the calculated values, just as a quick refer-
ence.

 

In the status bar on the right side you will find the calculation method, which was selected in the options-
calculation method.

 

So now you know how to work your way around in this part of the program.
In this short lecture you learned, how and where the cargo can be loaded, change friction, rotation and accel-
eration calculation for your cargo, how to read the data, and of course the result.
Lets’s go to the playground.

Lashing & Securing
When you click in your project explorer on the cargo we loaded, the Transformer 12-3456 Sample01.
Your viewport will automatically change to the Lashing & Securing viewport. In the main screen you will see 
different views of the cargo, starboard, portside, top, front and aft view of the cargo.
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Because this is an example already some chains and stoppers are attached to the cargo.
Let me first explain what you see.

On the left side, you will see three forms (undocked or docked, in this case docked) Toolbox, Chains, belts & 
Wires and Stoppers. The last two forms are the property forms from Chains, Belts & Wires and Stoppers.

In the centre you’ll see the different views. When your screen is not big enough you have to scroll down to 
show all. Also you get your views smaller or bigger using the sliders on the left side. The top slider is a standard 
zoom function, the bottom slider gives the opportunity to increase the relative space around the cargo where 
lashings can be placed.

On the right side, you will see one form (undocked or docked, in this case undocked) Lashing Calculation. Here 
you will see the result of all the tools you used on the form. When you scroll down on this form you will see that 
all requirements are met, because all the numbers are shown in green. Would this not be the case then some 
of them would be in red, meaning something is still not okay.
I will come back to that form later.

Let’s take the top view as starting point for my explanatory.

Here you see that I’ve added two (2) F1 stoppers on the portside and on the starboard side of the cargo.
In longitudinal direction I added for each side one (1) F1 stoppers and I also added four (4) chains on port and 
four chains on starboard side. According to the calculation this was sufficient to Lash & secure this item, the 
transformer 100mt.

From the toolbox you can easily add more and different stoppers or chains, belts and wires, just simply drag & 
drop them on the top view. Keep in mind that for good visual contrast we only allow stoppers to be placed on 
the top view. The chains, belts or wires can be added on any view.

Stoppers
When dragging & dropping a stopper onto the form, the default values are given to that item. In Tools-Options  
- Stoppers, you can changed the default settings.
Once you drag and drop them on your form you can access the properties of the item in the 
property form of each item. So let’s start with the stoppers. Click with your mouse on one of the stoppers on 
the form, then click on the docked form called stoppers. The following form will appear:
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Size
You will see at the size header, that different sizes are shown. When changing one of these settings the forces 
which are calculated are subject to change immediately, the result will be show in the low part of the form, 
where it says “securing capacity”. Very important is the impact height. When your cargo bottom is flat and you 
stow your cargo on normal dunnage (20mm), then your impact height will be 20mm. When you put your cargo 
on 120x120mm timber, your impact height will be 120mm.
When you change this by example you will see the result in the bottom part.
The capacity of your stopper will be minimized from 199,2 kN to 127,3 kN (keep in mind the safety factor of 
1,5), so it is very important to measure exactly the impact height of your stopper.
Play with it and you will notice some remarkable changes on capacities. Changing the length of the stopper 
(welding seam) or the weld throat thickness will have great influence on the result.

Misc
Here you see what type of stopper you selected, the rotation of the stopper and the safety factor. You can 
change the type of stopper by clicking on F1, a dropdown list will be shown and given you some options.
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When changing F1 to F2, you will see that the securing capacity doubles. Also you can change the direction 
of the stopper, here you can select for ps, sb, for, aft as direction. Of course the result will change in favor of 
the selected direction. You can also achieve this by double-clicking on the stoppers in the main viewport, the 
stopper will rotate clockwise.

Changing the safety factor will also have influence on the securing capacity. 
Securing devices normally use a safety factor between 1,35 – 1,5.

Securing capacity
Here you’ll see the result of the securing capacity for the stopper in the direction in which the stoppers is posi-
tioned, in this case portside. Because you calculated forces, all is expressed in kN (Kilo Newton) .

Chain, Belts & Wires
When dragging & dropping a chain onto the form, the default values are given to that item. In Tools-Options – 
Chains, Belts & Wires, you can changed the default settings.
Once you drag and drop them on your form you can access the properties of the item in the 
Property form of each item. Click with your mouse on one of the chains on the form, then click on the docked 
form called Chain, Belts & Wires. Following form will appear:
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Calculated Values
Here you see in the angles which are used for calculating the moments. The vertical and horizontal angles are 
derived from the position of each end of the chain. The end of the chain which is attached to the cargo we call 
’cargo cap’ and has three (3) coordinates: longitudinal, transverse and vertical. The end of the chain which is 
attached to the ship we call ‘ship cap’ and has also three (3) coordinates: longitudinal, transverse and verti-
cal.  When you calculate with these coordinates you can derive a direction of the chain, the length of the chain 
and the distance to the tipping axis of the footprint of the cargo. When using this coordinates system we can 
calculate in all directions with the chain. This means that a chain, which is normally used for tipping, also can 
have a longitudinal component. Therefore a chain calculation can result in more than one (1) direction. 
You can change the angle of the chain by typing in the desired angle in both vertical and horizontal direction, 
also you can do this by dragging one of the caps with your mouse to a different position.
When a ship cap is attached horizontal or higher than the value is not longer used for calculating uplift, only 
for tipping.

Chains
Here you see the MSL (Maximum Securing Load) which can be changed on this form. When you drag & drop 
a chain onto the form it will be set with default values. To change the default values go to Tools – options – 
Chains, Belts & Wires.

Also the safety factor can be changed here. Any changes you made will directly affect the result in this form.

Securing Capacity
Here you will see the result of what the chain will hold against external forces in shear force, tipping force and 
uplift force.

• Securing capacity in Shear forces will prevent the cargo from sliding in transverse and longitudinal direction.
• Securing capacity in Tipping will prevent the cargo from tipping in transverse and longitudinal direction.
• Securing capacity in Uplift will prevent the cargo from coming lose from the deck when the ship falls down in 

a wave pattern. At this moment the cargo will lose its grip on the friction and might become ‘light’. Depending 
on the user, you can select what is important for you: Tipping, uplift or both.

You can change the calculation settings in Tools-Options-Calculation method.

So in this topic you learned how to drag stoppers, chains, belts & wires to the form and change their position 
by entering different figures or using the mouse pointer. Also you learned to adjust the default values, how 
to change them, and using safety factors and change dimensions of welding length, welding throat, impact 
height, contact area.

I know this is a lot of data to remember, but one good thing is there. 
Tomorrow you can read the manual again. 
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Lashing Calculations

I will split the screen in two (2) parts and try to make it easier for you, can promise anything.

Cargo details
In the field ‘width and length cargo footprint’ the width and length of the cargo footprint is mentioned. Say your 
cargo is like in the example 8000 x 4000mm but the footprint is smaller i.e. 6000 x 3000mm then you can 
change this here. By default the width and the length of the cargo is used.
We need this to calculate the tipping and the uplift.

Wind area & Sloshing
When cargo is stowed on deck, it is submissive to wind and sloshing (water spray).
For calculating acceleration forces we use the full height of the cargo in the calculation for wind and up to two 
(2) mtr height for sloshing. For Tipping & Uplift we use only  ½ of the area.
 
The figures will automatically be filled by Length x (Height/2) for wind  and Length x height (max 1 mtr) for 
sloshing. You can change these figures in the property form and the calculation will immediately be adjusted.

Transverse and longitudinal offset of the COG is derived from input when cargo was added.
If the COG is offset in both longitudinal and transverse direction, the result might be that only one corner of 
your cargo has uplift.

User Defined accelerations
Some shipping lines have a certain minimum what they require in any load-out. If the DNV or IMO acceleration 
calculations are below their minimum they can adjust it to write the minimum requirements. You can change 
anything, you only have to meet the minimum requirements of DNV or IMO.
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Calculated  accelerations
This you cannot change. Here the calculated accelerations are shown. This will result in the following  
capacities:

• Actual Shear Forces
 Here the calculated acceleration are multiplied with the weight of the cargo, mentioned in kN.
 (when loaded on deck additional forces will be added). Where it says actual forces, it means these are the 

requirements you need to complete.
• Securing capacity
 Here you see what the stoppers and chains you added will bring you. If the figures are less than the actual 

needed forces then the figures will be shown in red, meaning you have to add more lashing & securing, is it 
green then it is okay.

This also goes for tipping & uplift, there is only one, additional to tipping.

Additional tipping
The tipping moment acting on a cargo unit in heavy weather, according to the Annex 13 calculation method 
is simply derived from the nominal transverse or longitudinal force, acting at the centre of gravity of the cargo 
unit, multiplied with the vertical distance of the force vector from a distinguished tipping axis. This approach is 
precise only for a cargo unit of the pin point size of COG and sufficiently precise for cargo units of moderate 
dimensions e.g. up to 10 mtr. height and/or breadth in the plane rotation
 

Now you learned how to use the lashing & securing calculations form. You are able to change footprint, change 
the wind lever and sloshing. You also learned how to enter user defined acceleration values. You learned to 
interpret the result of your lashing & securing plan.

Now the final printing the whole data. You did good so far, keep it up, almost there.
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Printing
When the loading is completed, the lashing & securing applied, then we can go for the final step.
Printing all documents and sign for approval.

When you go to File - print the following form will appear.

When you want to print, first you decide what to print. The options are not so much and most of the time you 
want to print Acceleration or Lashing & Securing.

In the top part you can choose between the ship definition, Voyage Cargo & Accelerations or the Lashing and 
securing. you decide whatever you want.

Then we proceed to the ship status, this I will explain a little bit. When you are using a lot of different ships in 
your project explorer, the view might get full, and of course we created the option to clean up a bit. just like 
home you have to clean up a bit, same goes here.

In the project explorer you have the option (right mouse click on ship, voyage) to select hide. When you click 
on a ship or a voyage that particular item will be stored in the history. If you want to revive it you can always go 
to the history form and ‘restore it again’.

Note:
Everything in your project explorer is ‘active’ if the icon in front of it is full colored. all other is inactive. Below this 
option you select the vessel you want, the active or inactive voyage you would like to print and then you select 
the cargo. Because there could be many cargoes on the voyage, here you can select which one.

Below this area you can select which images you want to see or which you don’t. if you play around it will be quite 
easy to look at the differences. Sometimes, when there is a lot of data to retrieve, it might take a little while to 
present it to you. The result will be shown when you click the large button ‘show report’, following might appear:
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Here you’ll see the basic data about 
vessel, cargo and calculation details 
used in the program.

Here you see the graphics where the 
cargo is loaded on the ship and how it 
is lashed.

If you played not so much around, it 
might look the same as the above.

 

In the manual, more extended expla-
nation, I will show you what everything 
means.
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The last page is the page where it 
comes to the point. Here you see what 
was required and if all these require-
ments are met, green is good, red is 
not sufficient.

I hope you learned a little bit on ‘Getting started’. You will learn a lot with the trial & error way, like we all do, 
and later when you ran into problems you will take the manual and read more.

Hope you enjoyed the basic explanation from my side, any comments, please send me a message.
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Exploring the VCC Interface
Well, here we are with a new version of VCC, and the first question on the minds of existing users is “How is 
the interface?” The answer is a happy “easy to use.” Most serious users would rather go through root canal 
surgery than have their user interface (UI) change, and Global Software has learned and respected this valued 
opinion by keeping the interface the best way. As you look around the interface, you’ll see that everything is still 
there but that VCC has a few additions. You may find yourself saying, as you navigate the interface, “Where 
did that come from?” But, just like encountering a new house in your neighborhood, over time you’ll become 
accustomed to the addition and may even meet some new friends. Why is the software interface so impor-
tant? Well, consider this: The interface is the set of controls that enable you to access the program’s features. 
Without a good interface, you may never use many of the best features of the software or spend a frustrating 
bit of time locating those features. A piece of software can have all the greatest features, but if the user can’t 
find or access them, then the software won’t be used to its full potential. VCC is a powerful piece of software 
with some amazing features, and luckily the interface makes these amazing features easy to find and use. The 
interface’s purpose is to make the software features accessible, and in VCC you have many different ways to 
access the features. Some of these access methods are faster than others. This design is intentional because 
it gives beginning users an intuitive command and advanced users direct access. 

Has the VCC interface succeeded? Yes, to a degree, but like most interfaces, it always has room for improve-
ment, and we hope that each new version takes us closer to the perfect interface (but I’m still looking for the 
“read my thoughts” feature). Global Software has built a loophole into the program to cover anyone who com-
plains about the interface—customization. If you don’t like the current interface, you can change it to be exactly 
what you want.

Learning the Interface Elements
If you’re new to the VCC interface, the first order of business is to take a stroll around the block and meet the 
neighbors. The entire interface can be divided into three easy elements. Each of these interface elements, in 
turn, has groupings of sub-elements viewed in dock panels.

The three main interface elements are listed here and shown separated in Figure 1.1:
• Menus: This is the default source for most commands, but also one of the most time-consuming interface 

methods. The menus are found along the top edge of the VCC window.
• Toolbars: VCC includes several toolbars of icon buttons that provide single-click access to
 features. These toolbars can float independently or can be docked to an interface edge. The main toolbar is 

the only toolbar that is visible by default.
• Dock panels: Configurable panels provide quick access to data features for several topics.
• Viewports: Separate views into the main viewport show the Left, middle and right viewpoints.
• Lower Status Bar: Along the bottom edge of the interface window is a collection of miscellaneous controls 

and information about results and calculation methods.

This section will help you to find your way in VCC. The main window, Menu, Dock panels and Tool- box are 
outlined in more detail. Although most of these tools and menus have a common design and usage, some 
features might be new and worthwhile to try out. Once all the navigation is clear, you can continue with the next 
chapter to learn how to use this application. 
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Controlling the viewports
VCC opens in a blank window, with only the main toolbar and status bar visible as shown below. When a  
project is opened, the centre viewport contains the graphical images, which gives you a detailed view of the 
ship, cargo, its position on the ship. Both sides of the window contain dock- panels with tables, options and 
menu’s. These can be enlarged to display data or properties, accompanying the specific objects that are dis-
played in the centre. In this chapter you will discover and navigate through all these elements. 

 

VCC Icon

A click on the VCC icon opens the standard menu which allows you to change the size of the active window 
or to close the application;

Main Toolbar
The main bar contains sub menu’s with various commands. This paragraph gives a brief explanation for each 
command. The complete functionality however, will be described in more detail in the VCC Stepping Stones 
chapter.
Menu bar
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Sub menu’s
• Cargo / jobs,  opens the cargo and jobs window, where all defined cargo and jobs are stored. New cargo and 

jobs can be created, the existing ones can be changed. 

• Ships or Voyages,  Creates new ships in the Project Explorer  and New voyages on current Ship.
 
 
• Here existing Cargo / Jobs or Projects can be opened.

• Projects, voyages can be exported and important to make live easy. Clicking here will open a dialog box, 

which shows you where to locate the export file or where the import file is located.
• Print, will give all voyages details on a document. By selecting various print options you can choose to in-

clude or exclude specific elements.
• Exit, of course close the program, all data will be saved automatically.
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• History will show you all ship, voyages and cargo which are temporarily hidden.

• Check for new ships / image sets,  enables downloading standard images of cargo, ships and color sets 
which are stored on the central VCC server.

• Check for new program updates, enables downloading it automatically. All updates are stored on the central 
VCC server.

• Here you can create backups and restore them if needed. Always good to be safe.

• Options, opens a form showing multiple tabs with default values and standards, which are used by the VCC 
application to perform correct calculations in the preferred unit of measure.

• Status bar, allows you to show (check) or hide (uncheck) the Status bar.

Status bar
At the bottom of the screen the Status bar is populated, which informs you on the calculated accelerations 
related to the current selected ship and cargo. 

Also the used calculation methods which are used in the current calculation will be displayed.
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Dock panel
Most information is captured within the sub menu’s and tables, which are most of the time hidden on the dock 
panels. This provides as much as possible space for the visual part at the centre of the screen. 

You can arrange the screen to your own preference by moving the menu’s and tables to the top, bottom, left or 
right. To do this you need to select (hold the left mouse button) and move the menu exactly to one of the pre-
ferred docking icons that appear as soon as you start moving around. Once the arrow moves over the docking 
icon it indicates where the menu will be positioned. You can then confirm by releasing the left mouse button 
and  the menu will stick to that position.
 

You can also arrange the menu’s and tables horizontal or vertical or arrange them as tabs. This can be ex-
ecuted via the tab icon that will appear in the centre of the docking icons by moving the menu across an exist-
ing docked menu.

Menu’s and Tables
The menu’s and tables can be enlarged to display metrics, standards, calculations or properties, accompa-
nying the specific vessel and/or cargo displayed in the centre of the window.  The following paragraphs will 
explain the various types of menu’s and tables and their specific properties. 



 Manual Visual Cargo Care
Demo

21

The menu’s give you the option to select values. As a first example the Project menu is described to show you 
how to open and move it.  
To activate the Project menu, you need to select it first from the Toolbar, via File -> Open -Projects 

The Project menu will pop up on the right side. The menu open in the auto hide mode as default, which means 
that it can be minimized by a double click on the right mouse button at the blue header. The window reappears 
if you move the pointer over the Projects icon.

By selecting the auto hide icon (as marked) you can disable the auto hide function. 

The menu remains visible and you can move it! Select the blue header (hold the left mouse button down) and 
drag the form to any area of the screen. Drop it (release left mouse button) where ever you please.

Further you can stretch or shrink the menu by grabbing the border and dragging it to the desired  size. To grab 
the border you need to move the pointer exactly on any line until the pointer changes into             .

Secondly, the toolbox is described to show how to switch between toolsets. In this example you can click (left 
mouse button) on the Stoppers label to populate the Stoppers toolset.  

Some tables contain an information pane, to provide details, 
explanation or instructions related to the selected value. In 
this case an instruction is given on what to fill in for ‘Length 
Over all’.  

If there is a lot of text stored in the information pane, you can 
enlarge the information section by selecting the pane and 
dragging it upwards. 

The Cargo table is used to illustrate the table characteristics 
and its specific buttons which allow you to navigate through 
the table records.  
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The records can be grouped or ungrouped, if applicable, by clicking this icon

Records within the table can be arranged in an alphabetical order via 

The record toolbar at the bottom of the table supports you to navigate through the set of records. The arrows 
let you move forward or backward from one record to another, one by one.  If there are many records you might 
prefer to scroll via the small record slider, above the record counter. 

 

In some tables you are allowed to append or delete records;

 

to append a new record,                                  

to delete a record.

Main viewport
the centre of the screen contains the graphical images of the cargo, ship or tools for lashing or securing. The 
image of the ship can be enlarged to provide you a detailed view of the cargo’s position on the ship and let you 
precisely apply the tools for lashing and securing.

At the left side of the image you will find the image size control. The slider allows you to adjust the image size 
by moving the it up (larger) or down (smaller). At the top of the control the size factor is displayed.

As soon as the image is larger than the screen, the vertical and horizontal 
scroll bars appear, to let you move the focus as preferred. Another scrolling-
option is to click somewhere on the image and just drag it around.
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Data basics
There are several objects that need to be defined before VCC can perform the necessary calculations. The 
objects can be divided into three types; ships, cargo and tools. The easiest way to define images is to down-
load them from the VCC website. Another option is to copy and modify existing images, but you can also cre-
ate ships and cargo from zero onwards. The object definition consists out of two main elements, the image 
and the object properties. The last element is of course the most important, all object specific values need to 
be absolutely right to assure a correct calculation by the VCC application. This section will show you how to 
perform all the steps to define your objects.
 
Create and Modify Ships
All ship’s properties can be changed. By selecting an object the properties table will become active and you 
can alter the values if needed. Please be aware that this will have its effect on the calculations! This means 
that you can also change predefined ships into your own specific ship with its own values, including the name 
of the ship. 

Besides downloading objects or modifying existing ships and cargo, you can also choose to add a new ship 
with blank properties and without a pre defined image. When creating a new ship you will also have to define 
the holds and deck panels. 

Within the Projects window, click the right mouse button. An action list will pop up, select Add ship.

A new ship is created as ‘New ship’.
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Ship properties form

Enter the name of the ship, the new name is directly re-
flected in the projects window. Next, select an image for 
the new ship, for example the VCC default image. 

You need to complete all other properties as Measure-
ments and Acceleration as they are applicable to the new 
ship .

Ship properties
The ship properties consist out of three elements, the 
ship itself, the holds and their deck panels. First the ship 
standard measurements and values are shown in the ex-
ample below.

Second, the holds and deck panels, they always belong together. A hold has its own set of deck panels. In the 
example below the ship contains three holds (record 1 / 3), where the first hold contains 4 deck panel records  
(record 1 / 4). Each deck panel record can contain multiple deck panels, in that case the panel numbers are 
separated by a comma.

For most values, the UOM (unit of measurement) can be changed, by selecting a UOM from the drop down 
box, becoming available when selecting the value field in the table.
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Add ship properties
When creating a new ship, all properties for the ship are blank and need to be completed. While entering the 
measurements in the properties table, the ship image will appear with the same proportions as entered. The 
ship is displayed as a side view, and a top view for tanktop, tweendeck and weatherdeck. 

This same applies for the holds and deck panels, when the hold record is entered the hold will be displayed 
on the ship, in the exact proportion as entered. The horizontal lines in the side view represent the level for the 
tweendeck and weatherdeck.
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The example hold as displayed on the ship has got the following values.

Deck panels can be entered as soon as the hold is defined. There are two types of deck panels, Weather deck 
and tween deck, indicating the level where they are applied. There can be multiple panels for one deck panel 
record, in that case the panel numbers should be separated by a comma. The width of the panels should be 
the same or a little less than the width of the specific hold. In the example below there is one record having 
six panels.

 
In this example, weather deck panels are show. All panels have the same size, but it is also possible to have 
a different size for each single panel. 
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Both holds and panels can be removed by deleting the record from the table. A dialog bow appears to ask for 
confirmation for the removal.

 

Remove / close or hide ship
Ships can be removed from the projects window by selecting the ship name, clicking the right mouse button 
and to select “Remove ship”.

 
By selecting “Hide ship”, the ship will move to “History”, where they can be unhidden again for further usage.
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By closing the ship it will show an inactive status by having a non filled circle, as shown in this example.

 
It can be re-opened, by selecting the ship, clicking the right mouse button and selecting Re-open ship.

 

Create and modify Cargo
Equal to ships, cargo can be downloaded and new created. To create a new cargo object, select Cargo / jobs,  
via Menu bar > File - New - Cargo / Jobs. The Cargo entry window allows you to add new cargo or change 
existing cargo. All defined cargo and jobs are stored in the Cargo entry table. 


